
Overview
Note: Throughout this documentation the term "appliance" is also considered to refer to IEC leads or extension leads etc.

The Manual PAT Software package is designed for recording and reporting of PAT Test results primarily from
manual PAT Testers such as the Seawards Primetest series.

It supports recording of standard Earth, Protective Conductor Current (Leakage), Touch Current, Substitute
Leakage, Flash and Load tests as well as Visual, IEC Lead pass/fail status, RCD trip times etc.

It also supports the recording of appliance risk assessment values and identification of hardwired (fixed)
appliances and Microwave leakage results for compliance with the IET 4th Edition recommendations of a risk
based approach to PAT and In service electrical testing.

It has been designed to provide rapid data entry via internal lookup and autocomplete logic for both in-house
test recording and reporting and to provide a platform for contract testers carrying out multiple sites and test
cycles.

It allows setting of default tests to be recorded and Pass/Fail value limits for data entry allowing a Virtual
PAT tester to be set up to reduce input errors when determining Pass or Fail status for an appliance test.

It also provides a consistent recording and reporting format for tests carried out with both manual and
automatic testers from different manufacturers without requiring separate software or reporting for each tester
utilised.

The software does not attempt to teach PAT testing or replace the roll of the testers skills and assumes the
user has the required knowledge of result interpretation and in the Code of Practice for PAT and associated
testing.

The system comes with a variety of licensing options from Free (Single company, limited tests) through
standard, (Multiple company test sets or test cycles) to a Pro version allowing creation of client viewer and
data distribution and billing/engineer costings etc..

 Free/Demo Standard Pro

No. of Result Sets/Sites/Companies 2 Unrestricted Unrestricted

No. of Tests per Result Set 200 Unrestricted Unrestricted

Images Supported 10 Total1 1 per test 6 per test

Pass/Fail Reports YES YES YES

Basic Re-Test Reporting YES YES YES

User Definable Pass/Fail Reports X YES YES

Disposals Reports X YES YES

Basic Statistics Reports X YES YES

Advanced Re-test Reporting X YES YES

Enhanced reporting and totalling X X YES

Exceptions Reporting X X YES

Data Export X X YES

Client Data viewer distrbution X X YES

Multi User Version Available See 2
Below X YES

1: Images printed in the free/demo version are in thumbnail sizes only, all other versions render to fill available space.

2: The Free/Demo version can be installed using the Multi-user/Network installer package to a shared network server/drive, but will only
allow ONE concurrent user to access the software.



System Requirements
Windows XP Service Pack 3 or above

Microsoft .NET Framework 3.51 Service Pack 1

600 x 800 VGA Monitor

Any W indows version specific requirements are covered in the installation section

Note: Windows 64Bit systems will run the software in .NET X86 processor 32Bit mode.



Installation
The single user VPAT installer is a 2 phase process. When launched you should see a dialog similar to the
following:

The above example shows the installer launched on a Windows 7 Pro system with the required .NET framework version already
installed.

On most systems encountered to date from W indows 7 to W indows 10 the pre-requisite .NET 3.51 sp1
framework has found to be already installed and it is therefore a simple matter to tick the license terms check
box and install the VPAT database.

However since late 2016 we have become aware that both W indows 8.x and 10 no longer appear the have the
.NET 3.51 sp1 installed by default. This should not present a problem as the installer will simply add the
installation of this Microsoft Framework to the list of actions to be preformed and again checking the license
acceptance followed by the install option will install both the framework followed by the VPAT database.

Note: if your system requires a reboot following the installation of the .NET framework then the installer may require to be manually
re-started depending on your systems security  settings and/or any anti-v irus product you may have installed.

If any issues are encountered with the .NET framework then please use the Framework Help Link on the top of
the install dialog or click here to review solutions from Microsoft



Multi-User Side By Side (SBS) Installation and Upgrading
Installation of the Multi-user SBS version of the VPAT Database is a two part process involving the installation
of the core program and data files to a shared server location, followed by installation of client files from this
shared location to individual user PCs attached to the network.

The VPAT SBS Installer package does not by itself install the client files required to access the software, this
is performed on each user/machine attached to your network that requires access to the shared system by
running the "VPATSBSClientsetup.exe" program from the shared folder that is installed with the core server
files.

For a first time installation it is recommended that an empty network folder is setup prior to installing the
core files package that the users have read/write/delete access to.

If upgrading an existing installation then the SAME folder MUST  be used as the destination and all users
must have exited the software prior to the upgrade being installed.

It is also recommended that this installation is performed on a server or workstation capable of running the
VPAT system (i.e. .net framework 3.51 sp1 installed) and that the automatic run option is taken at the end of
the installation to finalize any post installation tasks/upgrades required.

The SBS version can co-reside with the single user version on workstations attached to the network if
required.

If the SBS server component folder is moved either logically or physically at any point then the network users
will need to uninstall the VPAT SBS client software and re-install using the "VPATSBSClientsetup.exe"
program from the new network location.

A post installation check after installation or upgrading should be made on the shared folder and any sub
folders to confirm that users access rights are sufficient to perform the various functions required.



Registering and Upgrading
To register the downloaded software for the Standard or Pro version or if upgrading from the standard to Pro
or Multi-User versions, select the register or upgrade option from the help menu and enter the registration
license key as supplied.

If you are registering a multi-user version from the free Side by Side (SBS) network shared version, please use
the Maximum Users option from the Network option on the Tools Menu.

To obtain your registration license key, please visit our websites software product pages at
http://www.asgroupservices.co.uk and select the product and version you wish to purchase from the list
available.

If a particular version you require (Multi-user, Multi-license etc.) is not displayed, please use the contact us
function on the site or email us directly at sales@asgroupservices.co.uk with details of your requirements.

When upgrading any version of the software with an updated version downloaded from our website, you may
be asked to un-install the existing software before the upgrade can be applied. This upgrade process will NOT
remove any of your existing data from your system, and your data will automatically be migrated to the latest
version, the first time the upgraded software is run.

If upgrading from a single user standalone version to a Shared Side by Side (SBS) or Multi User Version the
software is provided with data import tools to facility the transfer of data to these systems.



Uninstalling Manual PAT
The program can be uninstalled from the Control Panel Add/Remove program option

However, uninstalling the program files DOES NOT automatically remove any data or images that has been
created when the program has been in use.

To physically remove this data, an administrator or the user who installed the program originally will need to
manually delete the data folders.

For standalone PC installations, the data and image files are stored in a folder structure AS Services\vpat

The location of which is defined by the W indows Operating system folder Common_appdata which on W indows
7 is normally C:\PROGRAM DATA, for other W indows versions (old and future) this is different or likely to be,
so users will need to check the Microsoft documentation for their specific version (XP, Vista etc….)

For Multi-user/Networks versions, the data location will be in the DATA folder immediately beneath the
original program installation folder on the shared network drive.



Hints & Tips
To maximise the automatic data completion and entry functions of the software to reduce input time of
results from manual test sheets a careful planning of the creation of Result Sets and planned testing cycles
should be considered.

Recommended Result Set Creation for basic single result set test cycles.

Create a new result set for each site/client AND test Cycle. i.e.

Set 1. Myclient1 - 2011

Set 2. Myclient2 - 2011

Set 3. Myclient1 - 2012

etc....

Then in the "Myclient1 - 2012" set the Lookup Set Name to "Myclient1 - 2011"

For multi site, multi client, multi test cycles, then the Pro version provides advances group lookup
functionality allowing multiple result sets to be combined for this functionality.

Recommended set up for multi-site result set creation:

Set 1. Myclient1 - Site 1 - 2012

Set 2. Myclient2 - Site 1 - 2012

Set 3. Myclient1 - Site 2 - 2012

Set 4. Myclient1 - Site 3 - 2013

Set 4. Myclient1 - Site 1 - 2013

Set 5. Myclient2 - Site 1 - 2013

etc...

In the above example Myclient1 has 3 sites with site 1 being re-tested in 2013. and Myclient2 has a single
site again retested in 2013 In this case both the group and lookup set features can be utilised to provide
lookup across the result sets as follows:

Create a group for Myclient1 and assign this to ALL the Myclient1 result sets with the group lookup
flag set.

In the Set 4. Myclient1 - Site 1 - 2013 also set the lookup set to Set 1. Myclient1 - Site 1 - 2012

When a test result Appliance Id is then entered in the Myclient1 - Site 1 - 2013 result set it will first
look for a match in the designated Myclient1 - Site1 - 2012 lookup set results.

If found then it will use this to pre-load the appliance details, if not found then will check the Group
lookup setting name and lookup flag and if set will the search all result sets with a matching Group
to try and locate the details.

The group and lookup set settings will also update the autocomplete functions of the Appliance description
and Locations fields during test result editing.

NOTE: To make full use of these functions special consideration MUST be given to the uniquness of the
appliance id's used across a groups result sets

Existing data or Appliance IDs

If the site or client has existing PAT data available or has existing appliance numbers, or asset ID's for
electrical equipment consider using these for your Appliance IDs.

If data is available in electronic form, you can consider using our data import/conversion service to pre-load
your dataset with this information. Use our contact form at http://www.asgroupservices.co.uk for further
information.

Appliance IDs and Descriptions

Assign Unique Appliance ID's for each appliance and site or client and maintain these across testing cycles.

For larger clients or multi-site setups where multiple results sets may be involved then the Pro version



provides additional grouping and lookup functions

To make full use of these features it is important that Appliance ID's are assigned and retained uniquely
across the whole of the group.

In this event an appliance Id prefix letter/number sequence is suggested for each Site involved. i.e. new
appliances are given id's on Site 1 like S1-xxxx, Site 2 S2-xxxx etc.

This approach will allow full use of the pro version group functions and lookup features as well as cater for
tracking equipment moving between clients sites.

Ensure descriptions contain sufficient detail to both identify the appliance and also provide reporting, search
and filtering capabilities.

Simply using "VDU" for a computer screen will not do this. A minimum recommended description would contain
make, model number and VDU i.e. "HP LA2205wg VDU"

This approach allows you to add value to your data by providing summary reports by filtering and locations
more accuratly.

Make use of the autocomplete functionality of the description and location fields to maintain consistancy of
this data across the result set. It will also assist with the actual result entry by adjusting default test
settings to those previously entered for this specific appliance description.

Testing and Data Entry

If locations are changing frequently during testing then it's recommended that the default location field of the
Result Set record is left blank and the autocomplete function is utilised during data entry.

If a significant number of tests are carried out on the same date at the same location then use the result sets
Default location field to set this, changing only when the test result sheets dictate a move to a new location.

As data entry is likely to occur AFTER the date of the actual testing, then test dates always default to the
values held in the Result Set records default values. Change the default test dates in the Result Set Record
when the test date changes.

For larger result sets (>500 tests) add test results in batches using the ADD MORE option when each record is
saved. This will prevent the software from re-checking and sorting the grid display data each time a test
result is added and will only perform this when the batch is completed.



Filtering Records
When a filter string is available for record display or in reporting options such as using the  filter tool on the
list display tab as below....

....then multiple filters can be set if required using the | (Vertical Bar) character between the words or phases
you wish to filter

For Example:

Entering the string FRIDGE in the above would restrict the displayed results list to only those records that
contain the characters FRIDGE in any fields as below

Entering the string FRIDGE | BEKO into the filter field results in only records containing the characters 
FRIDGE AND  BEKO in the displayed fields as below



Version History
15 May 2017 - Version 1.00.7.1

New and optimised autocomplete added to results fields entry.

"png" image format support added.

26 April 2017 - Version 1.00.7.0

New Microwave leakage fields and logic added to main test records and reporting

Fixes Bug with RCD Validation when Adding/Editing test records not re-setting cursor position correctly.

Updated Database files and further installer enhancements for W indows 8.1 & 10 installation issues.

12 February 2017 - Version 1.00.6.1

Installer and Help File updated addressing reported W indows 8.1 & 10 installation issues.

15 August 2016 - Version 1.00.6.0

Help -> About system information panel extended to include display of physical data file path

19 August 2015 - Version 1.00.5.9

Fixes problem of random word wrapping of Tester field details in reports

Fixes Bug with Appliance description and locations auto-complete loading ALL related descriptions and
locations during data editing and addition from group result sets instead of just those with group lookup
flag set

Adds extended group lookup to test details compare button

9 November 2014 - Version 1.00.5.8

Fixes Bug with Test Filter when "Has Images Only" flag set with NO other filter string.

9 November 2014 - Version 1.00.5.7

Add new Appliance Lists report

Adds additional record filtering capabilities

Fixes spurrious "Requires Open Connection" problem with Users table when launching program on some
multi-user systems.

5 August 2014 - Version 1.00.5.6

Adds new file menu print option to Details Tab to allow single page results report with images to be
produced

1 July 2014 - Version 1.00.5.5

Fixes Bug with test results filter not always returning exact filter string matches

Fixes output of invalid Earth Continuity and RCD test values in Data Export where Earth and RCD tests
are not checked.

Traps filters returning no results to prevent invalid record entry and other errors

19 June 2014 - Version 1.00.5.4

Fixes Bug with Add new test Button on Details Display tab becomming inactive

11 June 2014 - Version 1.00.5.3

New disposals summary report added.

New Image Storeage and linkage added to tests results database.

Optional Image output to client viewer creation added.

Large database optimization added to Appliance description and location autocomplete functions.



9 April 2014 - Version 1.00.5.0

Test results Appliance lookup enhanced to include optional Group lookup in Pro version.

Appliance and Location Autocomplete functions upgraded to include lookup set and new Group settings
values.

Fixes unexpected error message when Find used on an empty test result set

Prevents invalid Test record add function launching in Client Viewer version if tests results set is empty
or fails to load correctly.

Correctly disables reports options with empty tests results sets

Fixes problem when filter string set to "FAIL" and RCD test Failures not being included.

Correctly suppresses display of invalid advanced re-test reports options in Client Viewer Version.

Fixes problem of previous result set test record being displayed when adding a new results set and
defaults to list view display.

Fixes date limit problem with re-tests due summary and details reports.

8 March 2014 - Version 1.00.4.3

Fixes Installation, Program load and ADO.NET compatibility problems with some installations of 64Bit
W indows 7

Fixes Mixed 32Bit and 64Bit workstation execution in SBS version

Fixes Colour highlighting (Red/Green) of Flash Test Pass/Fail status not displaying correctly in List View.

Fixes problem of some "S/N" Serial numbers wrapping in Appliance description fields in reports.

Fixes problem of the next test date being exported for Failed or Disposed items.

Increases maximum database size from defaut 128mb to physical maximum of 4Gig

Adds new appliance Disposals identification and control.

29 December 2013 - Version 1.00.4.0

Fixes possible problem when switching between empty Result Sets

Adds support for Shared single user and Full multi-user installation and operation.

Adds support for Manual RCD test button results recording.

8 September 2013 - Version 1.00.3.7

Fixes spurious word wrapping in test and results fields in report printing.

Fixes Null object error when sorting list view items.

9 June 2013 - Version 1.00.3.6

Automatic result field entry selected when test flag checked to improve data entry speed.

4 May 2013 - Version 1.00.3.5

Next Test Due dates display and print suppressed for FAILED test results.

Failure test records now display and print before Pass (re-test) records for same appliance IDs on same
Test Date, irrespective of the physical order records are added to the result set.

New Retest Completed and Re-test outstanding summary and Details reports added to Standard and Pro
versions.

1 April 2013 - Version 1.00.3.0

Initial Full Release



Application Startup
When launched the application will open with a main screen similar to the following



Main Menu

 

The File Menu

The New option will create a new Result Set

Open will launch the Result Set selection dialog

Export will load the data export module.

Import is only available in the SBS and/or Multi-user versions

These 3 options are not displayed in the client viewer version.

Use the Page Setup to access printer, page and font settings for your reports.

The Print option is currently only available when the List tab or Details tab is active. This option will launch
the default .Net Print dialog and preview/print the currently displayed list results in a grid format.

Any Filter in effect and the current sort order is preserved.

Edit Menu

Provides standard windows Cut, Copy, Paste, and Select functions. The actual operation is dependant on the
field or cells currently being ediited. They are most useful when editing the Appliance test results Notes field.

The menu also provides the Find and Find Next functions for the test results Find tool.

Tools Menu

This menu option curently supports the Client Viewer creation tool in the Pro Version and is unavailable in
other versions

The network option is only available in the SBS Multi User version running on a shared drive.

Reports Menu

The main reports menu is seperated into 2 main sections depending on the version running. In the client
viewer version the Duplicate ID and Stat Reports are NOT displayed



In the free and standard versions the duplicate ID analysis and database statistic used primaraly for Tester
analysis and Billing are disabled and are only available with the PRO Version

Click on the report section you require on the menu image above to display details of each report available.



Result Set Tool Bar

 

Use the  tool to add a new set of test results to the database. You can also use the File->New option from
the main menu bar to perform the same function. In the Free version of the software you cannot add more
than 2 result sets to the database.

This tool is not displayed in the client viewer version.

Use the  tool to edit the details for the current result set

This tool is not displayed in the client viewer version and is disabled if no current result set is selected.

Use the  tool to delete the current result set and ALL the related test results.

This tool is not displayed in the client viewer version and is disabled if no current result set is selected.

Use the  tool to list all the result sets in the database as shown below, and select the set to make current.
The same action can be performed from the File->Open option on the main menu bar.

In the pro version the results sets are displayed as an tree view with results sets grouped in the tree by any
Groups assigned as in the following example.

Ungrouped result sets are listed first at the root level of the tree, the tree can be expanded or collapsed using
the + or - icons next to group names if present.

The Ok button is disabled if the selected item is a group and NOT a specific result set.

This tool is currently not displayed in the client viewer version



 

Add/Edit Result Set
when opened with the Add or edit Tools on the result set toolbar, or File->New from the main menu bar the
following dialog will appear.

This module allows you to edit the displayed details for the current result set or add a new result set record
to the database.

Using the Group edit button  gives access to the group dropdown values in the Pro Version only.

The above example shows a typical setup for a default testing pattern of Earth Continuity, Insulation and
Protective Conducter Current (Leakage) tests for class 1/2 Appliances.

Click on the fields in the screen image above for details of the fields and settings, or see the Fields definition
page.

Particular note should be taken of the Group, Group Lookup and Lookup Set Name fields for thier linking and
look up capabilities utilised in the system.



Add/Edit Groups
The Group features of the package are available in the Pro Version only

When opened with the Group Edit Button  on the result set window the following dialog will appear.

Use the toolbar buttons to add , edit , delete  and the navigator arrows to display the loaded group
names.

The delete button is also used to canel/abort changes when adding or editing group records

Use the Save button  to save new or editied record to the database.

The find button  allows you to locate a group description by entering a search string.

Finally use the Close Folder  button to end the group editing and close the dialog window.



Tab Menu
Clicking on the List Tab will display the list/grid view of the test results for the current result set.

The displayed results are dependant on any Filter settings in effect on the Test Results Tool Bar.

Clicking on a Column header will sort the list by that column in alternating Ascending or Descending order

Appliances marked as Disposed have their Appliance ID and Description displayed on Red in this view.

Clicking on the Details Tab will display the test result details for the selected test result from the List Tab
view.

If the current result set has a lookup set or group allocated, then a compare button may also be displayed
with the details

This button allows a quick repoprt of all matching appliance id records across the related lookup set and or
group to be displayed providing a quick history of the appliances test reuslts

Clicking the Image tab loads any images related to the to the current test record. A blank page is displayed if
no image has been added to the current test record.

The test results tool bar  Add tool is used to add images to this tab display



Test Results Tool Bar
The tests reults tool bar is located beneath the List, Details and Image tabs view area on the application
window and controls the addition, editing, navigation and filtering of the test results for the currently selected
Results Set.

 

W ith the List or Details tab pages displayed use the  tool to add a new test result to the current results
set. In the Free version of the software you cannot add more than 200 test results for a result set.

If this tool is used when the List display is active, then it will automatically switch to the Details tab view and
commence the entry procedure for a new test result.

W ith the Images Tab page displayed the  Add tool allows you to select an image to add to the current test
result record.

This tool is not displayed in the client viewer version.

Use the  tool to edit the details for the currently select test result. Again this will automatically switch from
the List display to the edit tab if required.

This tool is not displayed in the client viewer version and is disabled if no current test result is selected.

Use the  tool to delete the current test result.

This tool is not displayed in the client viewer version and is disabled if no current test result is selected.

The  tool will open the "Find" dialog below.

It can also be opened with the Edit->Find option from the main menu bar.

Selecting Find will search the current List grid for matching values to the text supplied.

If a filter is in effect, then find will only search for matches within the filtered test results.

Pressing the F3 Button or using the Edit->Find Next option from the main menu will attempt to locate the
next matching test result.

Use the  tool to filter the test results displayed.

Use set to filter the test results by the supplied filter string or clear to remove the current filter and display
all test results in the current results set.

Checking the Has Images Only checkbox will filter records that have a related image attached to them in
addition to any filter string supplied

If a filter is set the tool icon will change to 

If a filter returns no test results to display then a warning is diplayed and the filter is automatically cleared.

See Also: Filtering Records



 

Add/Edit Test Results
when opened with the Add or Edit Tools on the test results toolbar the following screen will appear.

When opened with the Add or Edit tools on the Test results tool bar you can add or edit the appliance and
associated test results.

Use the SAVE button to save the details to the current result set

When saving a new record, you will be prompted to Add More ? If you respond Yes to this dialog then the
software will reset the display ready to accept the next appliance and test results auto incrementing the
appliance ID if possible.

Responding No to the Add More ? dialog results in the software re-loading and sorting the Result Sets test
results and restoring to the Details View tab display. This can take several seconds for large result sets so it
is recommended that new records are added in batches utilising this functionality.

Click on the fields in the screen image above for details of the fields and settings, or see the Fields definition
page.

If the Notes button on the Details display is pressed when adding or editing a test result record then the
notes dialog will appear ready to accept textural notes regarding the appliance or test result



If pressed when in the Details Tab view mode then the dialog will open in a readonly mode with the buttons
replaced with CLOSE and EDIT Button.

Pressing the EDIT Button in this mode will allow the dialog to move into the editing mode allowing changes to
the content and providing the SAVE and CANCEL options as above.

The notes feature is provided primaraly for allowing entry of test failure notes or remedial works
undertaken/required etc.

Notes saved for an appliance test can be selected and filtered in various reports options.

You can ue the Fuse Changed checkbox to record appliance re-fusing/fuse changes for added reporting options



Adding & Managing Images
When the image tab is selected for a test record, the software will scan for any previously added images or
display a blank image canvas if none have been added or found as below.

Using the  Add tool on the Tests tool bar will launch the windows file browser allowing you to select a
Bitmap (.bmp), JPEG (.jpg), PNG (.png) or GIF (.gif) image file to be added to the displayed test record.

This tool is disabled in the client viewer version

If a valid image is opened then it will be displayed on the Image Tab canvas as in the example below.

Using the right mouse click on an image will bring up the following menu options relating to the image.

Select copy to copy the image to the windows clipboard for pasting into other programmes

Select Delete to remove the image from the database (Note: Deleting an image from a test record will only
remove the VPAT copy of the image and NOT the original image file.)

Select properties to display the Image properties

The delete option is not available in the client viewer version

If an invalid image format is loaded or a corrupt image file is found in the image store then the following will
be displayed.



You can right click on the error icon and use the Image delete option from the popup context menu to clear
this error.

The free/Demo and Standard versions allow one image per test record to be added, the Free/Demo version has
a further restriction of a maximum of 10 images in total to be added.

The Pro version allows up to 6 images to be stored per test record as in the example below



Export
The Export option is available in the Pro Version only and is accessed from the File-&gtExport option on the
Main Menu Bar

The option is disabled unless the default List Tab is displayed in the main application window

The export formats options are Comma seperated (CSV), Tab delimited text (TXT) or HTML formats.

If you check the Include Column and Row Headers, then the data will contain an additional row containing the
displayed column headers and an additional column containing the row details (Currently this is a empty
column).

Any test results filter and Column sort order in effect also applies to the exported data.

Once the export data has been compiled you will be required to supply a file name to save the data to.

Note: The associated test result Notes field is currently NOT exported



Import
The Import option from the Main Menu is available in the SBS or Multi User versions only

The function permits users upgrading from a standalone single user version to import result sets and test
results from existing versions into a shared or Multi User SBS version.

When launched from the file menu option the import module will scan the local workstation drive for a single
user VPAT database.

If found it will then attempt to open the result sets held in the database and present a dialog similar to the
following allowing the user to select a result set to import into the SBS version database.

When a result set is selected for import the import module will perform a series of checks and tests to
validate the import selection BEFORE actually attempting to physically import the data to the active SBS
version

The single user database fields (Schemas) are compared with those in the target SBS database and any
mismatches are reported as below and the import terminated.

This problem can be resolved by checking the single user system version against the current SBS version
running and upgrading the single user version present on the local workstation BEFORE performing the import.

Once any problems with the schemas have been resolved, the import module will go on to check the physical
records and index consistancy and report the record summary that will be imported and ask for confirmation of
the import.

NOTE: If a result set with the same name name already exists in the SBS target database then a Duplicate
exception is raised and the import aborted without any data being imported as the example below.



If the import is completed then the SBS database will contain a copy of both the result set and Test results
from the original single user database.

NOTE: If a Lookup result set is specified in the original single user result set then this will need to be
manually reset based on the results sets stored in the new SBS database.



Print and Page Setup
When opened with the main menu Page Setup options from the File or Reports menus the following dialog will
appear allowing control of the Printer, page size,layout and fonts used for the Print and reports functions of
the software.

Changes to printers, page and font settings made in this and associated dialogs below are discarded if the
Cancel button is pressed on this dialog.

Pressing the "More Page Settings" button launches the default Net Page Setup dialog. allowing the user to
change margins and other paper and page layout options for the selected printer.

Pressing the "Fonts" button launches the Fontset editor dialog below



When the application is started a default Font Set is created as follows:

Font Name Default Font

Title Arial 16 Point Bold
Subtitle Arial 12 Point Bold

Header Arial 10 Point Bold

Fieldnames Arial 10 Point Bold

Data Arial 10 Point Regular

Footer Arial 8 Point Bold

Note: At present the Header and Fieldnames fonts are shared in the Font Setup dialog and are displayed as a
common "Header" option.

The following shows the main font applications within the grid style reports

and Rows style report layouts



Print
When a Print request is made from the File or Reports options then the default .Net windows print dialog will
be opened

The actual dialog displayed will depend on the W indows version you are running, but the actions will be the
same

The dialog allows you to change the target printer and access the printers driver settings with the Properties
or Preference button.

it however does not allow access to change fonts or margins that are specific to the print and reporting
functions of the software itself. It is therefoe recommended that the Page Setup options available on the
main menu bars are used to assign the printer and page layout settings prior to printing.

When Print is selected the software will by default create a preview of the document from which the final print
to the selected file or device can be made.



Basic Reports
The following Reports are available from the Basic Reports Option in the Main Menu Reports dropdown menu

Appliance Lists

Appliance Summaries

Disposals

Appliance Lists

This report will list the Appliance description, serial number and location of appliancess depending on the
filter supplied or all if the filter string is blank

The report can be ordered by various combinations of appliance Id, Description, serial number or location.

Appliances marked as Disposed are ignored, but Failed appliances are included.

Appliance Summary Report

This report allows you to produce totals for appliance descriptions. Options include allowing these to be
totalled (Grouped) by appliance description Location + Appliance or Appliance + Location.

All 3 reports add value to your data by providing basic analysis of quantities of appliances tested. It is
especially useful for larger organsations which may require testing costs to be apportioned by Location
(Department)

You can add a filter to the report. By default both Failures and disposed appliances are not included, you can
however override this by checking the Include Fails option.

The include totals option when checked will produce a total count of appliances for the report geneated. This
option is only available in the Standard and Pro Version of the software.

Below is a sampe report grouped by Appliance + Location and with a filter set to the Phrase 'VDU'

Disposals Summary Reporting



This report will produce a listing of appliance details that have had the disposed flag and date set from the
current results set.

In the Pro version you can optionally set additional disposals from related Group related results sets to be
included if a Group has been specified for the current result set.

By checking the By date flag and entering start and end dates the report can be restricted to disposal dates in
the selected range.

This report is disabled in the Client Viewer and Free/Demo versions.

Below is a sample disposals summary report for a "Sample Set" group between March and May 2014

Back to Menu



Tests Reports
Various tests results reports are available depending on the version running as follows:Main Menu Reports
dropdown menu

Pass Report (All Versions)

Fail Report (All Versions)

User Defined (Standard & Pro Only)

Re-Test Reports (Not Viewer)

Tests Pass and Fail Reports

The Tests Pass and Fail reports operate identically except one will report only tests where ALL results are set
to PASS the second reports any tests with ANY result with a FAIL status.

When run the reports will launch the Print dialog and produce reports similar to the following

User Defined Tests Reports

These reports are available in the Standard or Pro versions only.

The report title and sub title can be manually set. Pass and/or fail reports can be selected within date ranges
or only for those test results containing information in the test results notes field

Results can also be filtered for both Hardwired flagged or Microwave Tested appliances only or to exclude
these results.



By default Hardwired and Microwave tested results are included BUT disposed items are NOT included.

Re-Test Reports

A set of reports are available for displaying or printing re-test schedules from existing test result sets ranging
from simple summary and details schedules available in all versions to more complex reporting for in-progress
re-test cycles availabe in the standard or pro versions.

Disposed appliances are ignored in the re-test reports except the Re-Tests Completed, where if any are
identified they are marked in an additional checkbox column on the report.

Totals and sub totalling options are available only in the standard or Pro versions.

Sort options are limited in the client viewer and free versions.

Report Details Version

Basic
Summary

A summary of Next Test Dates sorted by Appliance Descriptions and Locations by
Month from the current results set.

ALL

Basic
Details

A detailed list of Appliance details, location, risk and next test dates.

Useful for engineers carying out re-test cycles reducing time to identify and record
appliance details.

ALL

Re-Tests
Completed

A list of Appliances and locations that are due for re-test in the lookup set that
have new test results in the current selected result set.

Standard
& Pro

Re-Tests
Outstanding
Summary

A list of Appliances and locations that are due for re-test in the lookup set that DO
NOT have new test results in the current selected result set. 

The report is useful for monitoring the re-testing cycle for a client or site. 

In an ideal world at the end of a re-test cycle the report should only contain
appliances that are no longer present on the site or have been disposed of since
the last testing cycle but not flagged as Disposed.

Standard
& Pro

Re-Tests
Outstanding
Full Details

As per the Re-Tests Outstanding Summary but contains additional details of Class,
Voltage and rating etc. from the lookup set test results. 

The report is useful for engineers carrying out re-tests allowing rapid identification
of the appropriate tests to use for the previously identified class, ratings, fuse
settings etc. without the need to re-check or identify the information from the
appliance plates or documentation.

Standard
& Pro



Tests Reports
Various tests results reports are available depending on the version running as follows:Main Menu Reports
dropdown menu

Pass Report (All Versions)

Fail Report (All Versions)

User Defined (Standard & Pro Only)

Re-Test Reports (Not Viewer)

Tests Pass and Fail Reports

The Tests Pass and Fail reports operate identically except one will report only tests where ALL results are set
to PASS the second reports any tests with ANY result with a FAIL status.

When run the reports will launch the Print dialog and produce reports similar to the following

User Defined Tests Reports

These reports are available in the Standard or Pro versions only.

The report title and sub title can be manually set. Pass and/or fail reports can be selected within date ranges
or only for those test results containing information in the test results notes field

Results can also be filtered for both Hardwired flagged or Microwave Tested appliances only or to exclude
these results.



By default Hardwired and Microwave tested results are included BUT disposed items are NOT included.

Re-Test Reports

A set of reports are available for displaying or printing re-test schedules from existing test result sets ranging
from simple summary and details schedules available in all versions to more complex reporting for in-progress
re-test cycles availabe in the standard or pro versions.

Disposed appliances are ignored in the re-test reports except the Re-Tests Completed, where if any are
identified they are marked in an additional checkbox column on the report.

Totals and sub totalling options are available only in the standard or Pro versions.

Sort options are limited in the client viewer and free versions.

Report Details Version

Basic
Summary

A summary of Next Test Dates sorted by Appliance Descriptions and Locations by
Month from the current results set.

ALL

Basic
Details

A detailed list of Appliance details, location, risk and next test dates.

Useful for engineers carying out re-test cycles reducing time to identify and record
appliance details.

ALL

Re-Tests
Completed

A list of Appliances and locations that are due for re-test in the lookup set that
have new test results in the current selected result set.

Standard
& Pro

Re-Tests
Outstanding
Summary

A list of Appliances and locations that are due for re-test in the lookup set that DO
NOT have new test results in the current selected result set. 

The report is useful for monitoring the re-testing cycle for a client or site. 

In an ideal world at the end of a re-test cycle the report should only contain
appliances that are no longer present on the site or have been disposed of since
the last testing cycle but not flagged as Disposed.

Standard
& Pro

Re-Tests
Outstanding
Full Details

As per the Re-Tests Outstanding Summary but contains additional details of Class,
Voltage and rating etc. from the lookup set test results. 

The report is useful for engineers carrying out re-tests allowing rapid identification
of the appropriate tests to use for the previously identified class, ratings, fuse
settings etc. without the need to re-check or identify the information from the
appliance plates or documentation.

Standard
& Pro



Duplicate Id Exceptions
The following Report is only available in the Pro Version from the Main Menu Reports dropdown menu

When selected the software will check the current result set for any test results that have the same
(Duplicate) Appliance Id numbers

The report is valubale for highlighting either genuine reasons for duplications of an Appliance number (i.e. as
above a failure that is later retested) or where data entry or recording during actual testing is at fault (as
below).

Back to Menu



Stats Reports
The stats reports package is available in the Standard and Pro versions only from the Main Menu Reports
dropdown menu.

The options available will depend on the specific report selected and the Standard or Pro version running

The various Stats reports are available from the Report Type drop down on the following dialog:

The Global option (Pro Version Only) allows the report to be generated for ALL Result Sets in the database,
rather than the default Current Set.

The Auto Title option (Pro Version Only) can be used to disable the default automatic report title and sub title
creation for manual input.

The Include Totals and Sub Totals (Pro Version Only) allows column totals and subtotals to be produced in the
reports where applicable for counts and totals.

Fuse Changes

Tests Summaries

Tester Summaries

Fuse Changes

Allows reporting of fuse changes logged on the test results notes dialog

The Pro version allows additional grouping and totalling by Appliance Description or Class

Other Stats Reports

Test Summary Reports

Produces reports for Pass, Fail and Total test results recorded for the current or all Result Sets

When combined with the Date selection or Date and test type grouping options (Pro version), it is particularly
useful for generating costing and billing information.

Other Stats Reports

Tester Summary Reports

Produces reports for Pass, Fail and Total test results recorded for the current or all Result Sets grouped by the
Tester field values

When combined with the Date selection or Date and test type or class grouping options (Pro version), is
capable of reporting test engineers activity on weekly or monthly tests performed for per test payments and
billings.

Other Stats Reports



Create Client Viewer
The Pro Version of the software allows the creation of a distributable copy of the Client Viewer version of the
software and the current result sets test results.

The minimum system specification of the clients target machine is identical to the minimum system
specification for running the Pro version software on the source machine

The default folder containing the files and data will be created in the VPATViewer folder within the users
Documents folder. This location is changable by modifying the Output Folder path in the dialog.

Note: The viewer creation process requires read/write access to the output folder, therefore you cannot create the folder directly to a
Read Only device or media.

By default any Images attached to the tests results are NOT copied to the output folders or database,
however these can be added to the client viewer output by checking the Include Images checkbox.

Checking the Create Autorun option will add an autorun.inf file to the output folders root directory. This can be
used to automatically launch the viewer from a distributed CD/DVD.

Note: The action of the Autorun.inf file is dependant of the operating system and security employed on the clients machine for
removable media. For more information please refer to the relevant Microsoft documentations for each target machine.

If the Run Viewer after create option is checked and the viewer software package creation is successfully
compiled then the Pro software running will close down and the viewer package created launched.

Note: When the viewer software is closed it WILL NOT automatically restart the pro version running. This will have to be re-run in the
normal way if required.

Distributing the Viewer Package

Once created the output folder will contain a files and folder list similar to the following:

The files and folders contained in the output folder form a .Net "Side by Side" installation of the client viewer
software and data.

They can be distributed using XCOPY, Zip or W indows installer methods and technologies.

It is important that whatever method is used to distribute that the files and folder structures are maintained.



Network Tools
The network tools module is available in the SBS Multi-user version of the software and can only be run by
local administrators or if the software is launched under administrator user profile.

The module will display the current user, application location and details of the maxiimum licensed concurrent
users and users currently recognised by the software.

Any users that are currently accessing the database are indicated by the logged in checkbox.

Use the Maximum Users button to register the multi-user version or register a user pack upgrade.

Using the refresh button will update the current state of the users list.

Hi-lighting a user and using the logout button causes a closedown application message to be sent to the
remote users desktop as below.



Appliance ID

A Required user supplied appliance ID. Numeric elements of the ID are auto incremented during multi-record
addiions of test results. Particular attention of the appliance ID assigned and Lookup, comparison and re-test
reporting within the system should be taken.

If a lookup Set name or group name and lookup is defined then other test fields will automatically be filled
out during addition of a new test result based on the previous values stored in the lookup or Group sets test
records for the matching Appliance ID

See Also: Hints & Tips for further information on assigning appliance IDs

Appliance Description

A required user supplied description of the appliance. The field has autocomplete functionality built in to help
maintain consistancy for find and filter operations within a result set.

Class

The electrical class of the appliance. (Required)

Currently supported values are Class 1,2,3, IEC for Leads and extensions and Other.

The appliances class setting will determine which logical test results are required, optional or invalid. i.e. you
can't enter an Earth Continuity for a Class 2 appliance etc...

The IEC Class additionally allows entry of a Pass/Fail status for lead polatity etc. depending on the
capabilities of the PAT tester used.

Disposed and Disposal Date

An optional flag for appliances that have been disposed of by scrapping, selling or otherwise.

When checked a disposal date can be entered, if unchecked the date field is not displayed

Appliances marked as disposed can be optionally included or excluded from various reports

Earth Continuity

The results set record contains the user definable default test current and Ohms resistance pass limit for this
test.

When a test result is entered by checking the Earth Continuity test then the user can override the test current
applied and enter the actual Earth Resistance measurment in Ohms

If the resistance is greater than the pass limit set in the result set then the test status will automatically
change from pass to fail. This also can be overridden if required for individual test result records.

The Earth Continuity test result fields are disabled for Class 2 or 3 appliances or if the Visual or RCD Test
Type is specified

Flash

The results set record contains the user definable default test voltage (1500 or 3000V) and MilliAmp (Ma)
leakage pass limit for this test.

When a test result is entered by checking the Flash test then the user can override the test voltage applied
and enter the actual current measurment in Ma

The result can be entered as the testers maximum precision such as "<0.25"

If the current is greater than the pass limit set in the result set then the test status will automatically change
from pass to fail. This also can be overridden if required for individual test result records.

The result field supports upper and lower limit results autocomplete values (<n.nn and >n.nn)

The result fields are disabled if the Visual or RCD Test Type is specified

Fuse

An optional text field to record the appliance fuse fitted. i.e. 5A or 3Amp etc..

Fuse Changed

An optional field on the test results notes dialog that allows additional reporting/costings of fuse changes/re-
fusing remedials.



Group

An optional Group name to link multiple result sets The group name is used for both display and selection of
result sets and optionally, by use of the attached lookup flag, for additional lookup and autocomplete
functionallity during test results addition and editing.

It is important to note that these features are only useful if appliances carry forward the same IDs between
test cycles as recommended by current Codes of Practice.

The Group function is only available in the Pro version of the software.

Group Lookup

When a Group is associated with a Result set and checking the associated Lookup check box then ALL Results
Sets with the same group will be included in lookup and autocomplete functions during test result addition
and editing.

By default the Group lookup option is not checked and only the Lookup Set (if specified) will be used for these
functions.

It is important to note that these features are only useful if appliances carry forward the same IDs between
test cycles as recommended by current Codes of Practice.

The group lookup option is only available in the Pro Version

Hardwired

This field should be checked if the appliance is connected to the supply via a hardwired (fixed) connection
such as a fused Spur

Leave unchecked if the appliance is connected via a plug or IEC lead etc.

Hardwired or "Fixed" appliances now come under the IET 4th edition guidlines for testing. This flag allows you
to identify these for seperate reporting as invariably these appliances will take longer to test and will require
extra levels of expertise in the disconnection and re-connection processes involved.

IEC Lead

For testers that support specific lead tests, setting the appliance class to IEC allows then entry of a Pass/Fail
status for the lead test.

If supported it is recommended that this class be used for all IT type (C5, C8, C13 etc.) leads and extension
leads as the IEC class coding also allows entry of other Class 1,2 or 3 test results.

This field is disabled for all classes except IEC or if the test type is not FULL

Insulation Resistance (IR)

The results set record contains the user definable default test voltage (250 or 500Vdc) and MOhms resistance
pass limit for this test.

When a test result is entered by checking the Insulation Resistance (IR) test then the user can override the
test voltage applied and enter the actual Resistance measurment in MOhms

The result can be entered as the testers maximum precision such as ">19.99"

If the resistance is less than the pass limit set in the result set then the test status will automatically change
from pass to fail. This also can be overridden if required for individual test result records.

The result field supports upper and lower limit results autocomplete values (<n.nn and >n.nn)

The result fields are disabled if the Visual or RCD Test Type is specified

Load

There are no default pass/fail settings in the Result Set record for this test since the pass/fail value is
dependant on the expected maximum load from the appliance manufacturers information and the reading
actually achieved.

The result field supports upper and lower limit results autocomplete values (<n.nn and >n.nn)

The result field is disabled if the Visual or RCD Test Type is specified.

Location

An appliance location description (Optional). Used by appliance summary reports. The field has autocomplete



functionality built in to help maintain consistancy for find and filter operations within a result set.

Lookup Set Name

A Result Set Name linking the current Result Set to an existing set of test results within the database.

Used during new test result additions to pre-load data fields with a previous set of appliance details and test
parameters from the matching appliance ID in the lookup results set. It is also used in compiling comparison
reports for appliances.

It is important to note that these features are only useful if appliances carry forward the same IDs between
test cycles as recommended by current Codes of Practice.

Microwave Leakage

The Microwave Leakage pass/fail value in mW/cm2. During Test record addition or editing the test and value is
disabled for Visual, RCD or Socket Test Type or if the appliance class is an IET cable

Protective Conductor Current (PCC)

(Previously Leakage)

The results set record contains the user definable default MilliAmps (Ma) current pass limit for this test.

When a test result is entered by checking the PCC test then the user can enter the actual current measurment
in Ma

The result field supports upper and lower limit results autocomplete values (<n.nn and >n.nn)

The result can be entered as the testers lower precision limit such as "<0.10"

If the current is greater than the pass limit set in the result set then the test status will automatically change
from pass to fail. This can be overridden if required for individual test result records.

The result fields are disabled for Class 2, 3 appliances or if the Visual or RCD Test Type is specified

For Class 2 or 3 Appliances the Touch Current (TC) fields should be used to record Leakage values.

Rating

An optional text field for recording the appliance power rating. i.e. 125W or 3Amp etc....

RCD

The results set record contains the user definable default test current and MilliSeconds (Ms) trip pass limit for
this test.

When a test result is entered by checking the RCD test then the user can override the test current applied and
enter the actual trip time measurment in MilliSeconds

If the trip time is greater than the pass limit set in the result set then the test status will automatically
change from pass to fail. This also can be overridden if required for individual test result records.

If a Milliamp test current of 0 or blank is entered then the Millisecond value is ignored and the result is
considered to be a simple PASS or FAIL on a manual RCD trip button test and is reported accordingly.

The RCD Test result fields are only available if the test type is set to RCD

Result Set Name

A user defined name for a result set. The name is used in select dialogs and for Lookup, Linking and Report
Titles.

Although duplicate names are permitted each set is still uniquely identified internally in combination with the
Result Set Number.

Result Set Number

A computer generated Number unique for each result set in the database. This number is for reference only
and is not editable by the user.

Risk

In order to comply with the IET 4th Edition Guidelines for In-Service Electrical Testing the software supports
the assignment of a risk assessment value to each test.



The results set record contains the user definable default value ranging from Very Low through to Very High.
The Default Value is Normal

When a test result is entered this value can be overridden for each individual appliance.

In addition to assigning a risk level the default Next Test Due date will be adjusted based on the following
table, but can still be manually changed.

Risk Level From Test Date

Very Low 48 Months

Low 24 Months

Normal 12 Months

High 6 Months

Very High 3 Months

Serial Number

An appliance serial number (Optional)

Sub. Leakage

This test (Substitute Leakage) is the lower voltage alternate test to the Protective Conductor Current (PCC)
test. Where possible the PCC test should be conducted in preference.

The results set record contains the user definable default MilliAmps (Ma) current pass limit for this test.

When a test result is entered by checking the Sub. Leakage test then the user can enter the actual current
measurment in Ma

The result can be entered as the testers lower precision limit such as "<0.10"

The result field supports upper and lower limit results autocomplete values (<n.nn and >n.nn)

If the current is greater than the pass limit set in the result set then the test status will automatically change
from pass to fail. This can be overridden if required for individual test result records.

The result fields are disabled if the Visual or RCD Test Type is specified

For Class 2 or 3 Appliances the Touch Current (TC) fields should be used to record Leakage values.

Test Date & Next Test Due

The date that the test was performed on the appliance and the date the next test is due. These dates default
to those set in the Result Set default values

If the appliance risk status is changed, then the Next Test date will be adjusted according to the risk level
selected, but can be overridden.

The Next test due date output and display is suppressed for FAILED appliance test results or appliances
marked as DISPOSED.

Test Type

A required test type for the test performed on the appliance. The supported values are:

FULL - A full visual and electrical test inspection. Results entry permissable is dependant on the
Class of the appliance. i.e Earth Continuity is disabled for Class 2 and PCC (Leakage) becomes Touch
Current etc...

VISUAL - A Visual inspection only, all other results fields are disabled.

RCD - Allows recording of visual inspection and RCD trip currents and times, including manual test
button results.

Socket - When used with the "Other" Class Setting allows visual and other results to be recorded
including RCD tests. This can be useful if non standard PAT testing is also being carried out on under
desk Tap-off and busbar system sockets.

Tester

An optional text field to identify the tester. This field is used for personnel carrying out the actual test and for
producting test results statistics by Tester for payment and billing reporting in the Stats Reports module.



Touch Current (TC)

(Previousy Leakage)

The results set record contains the user definable default MilliAmps (Ma) current pass limit for this test.

When a test result is entered by checking the Touch Current test then the user can enter the actual current
measurment in Ma

The result can be entered as the testers lower precision limit such as "<0.10"

The result field supports upper and lower limit results autocomplete values (<n.nn and >n.nn)

If the current is greater than the pass limit set in the result set then the test status will automatically change
from pass to fail. This can be overridden if required for individual test result records.

The result fields are disabled for Class 1 appliances or if the Visual or RCD Test Type is specified

For Class 1 Appliances the PCC fields should be used to record Leakage values.

Visual Test

As a Visual Test is ALWAYS required by the Code of Practice then this Pass or Fail Status is required for ALL
Test Types

Voltage

A required Voltage rating for the appliance. Supported values are 110, 240 or 415V. The default value is set in
the Result Set default values


